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1 Preface 
OpenL Tablets is a Business Rules Management System (BRMS) based on tables presented in Microsoft Excel 
documents. Using unique concepts, OpenL Tablets facilitates treating business documents containing business 
logic specifications as an executable source code. 

OpenL Tablets provides a set of tools addressing BRMS related capabilities including OpenL Tablets WebStudio 
that can be used for creating, testing, and managing business rules and business rule projects, and OpenL 
Tablets Rule Services designed for integration of business rules into customer applications. 

The OpenL Tablets Installation Guide provides instructions for installing and customizing OpenL Tablets 
software. The document describes how to install OpenL Tablets under Apache Tomcat, deploy, and set up OpenL 
Tablets Rule Services. 

This section includes the following topics: 

¶ How This Guide Is Organized 

¶ Audience 

¶ Related Information 

¶ Typographic Conventions 

1.1 How This Guide Is Organized 
Information on how to use this guide 

Section Description 

Before You Begin Lists system requirements for installing and using OpenL Tablets software. 

Install OpenL Tablets WebStudio under 
Apache Tomcat 

Explains how to install OpenL Tablets WebStudio under Apache Tomcat. 

Deploy OpenL Tablets Rule Services under 
Apache Tomcat 

Designed for rule developers who need to use business rules as separate 
web services. 

Install OpenL Tablets WebStudio and 
OpenL Tablets Rule Services on 
WebSphere Application Server 

Explains how to install OpenL Tablets WebStudio and OpenL Tablets Rule 
Services on WebSphere Application Server. 

Install OpenL Tablets WebStudio and 
OpenL Tablets Rule Services on JBoss 
Application Server 

Explains how to install OpenL Tablets WebStudio and OpenL Tablets Rule 
Services on JBoss Application Server. 

OpenL Tablets WebStudio and OpenL 
Tablets Rule Services Integration 

Explains how to set up OpenL Tablets WebStudio and OpenL Tablets Rule 
Services as an integrated environment. 

¶ Troubleshooting Notes 

¶ Frequently Asked Questions 
Provides useful information related to OpenL Tablets installation. 

1.2 Audience 
This guide is mainly targeted at business users and rule experts who define, view, and manage their business 
rules and rule projects via OpenL Tablets WebStudio. Developers can also use this document to learn how to 
install and set up OpenL Tablets Rule Services. 
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Basic knowledge of Java and Apache Tomcat is required to use this guide effectively. 

1.3 Related Information 
The following table lists sources of information related to contents of this guide: 

Related information 

Title Description 

[OpenL Tablets WebStudio User Guide] Describes OpenL Tablets WebStudio, a web application for managing 
OpenL Tablets projects through web browser. 

[OpenL Tablets Reference Guide] Provides overview of OpenL Tablets technology, as well as its basic 
concepts and principles. 

http://openl -tablets.org/  OpenL Tablets open source project website. 

1.4 Typographic Conventions 
The following styles and conventions are used in this guide:  

Typographic styles and conventions 

Convention Description 

Bold ¶ Represents user interface items such as check boxes, command buttons, dialog boxes, 
drop-down list values, field names, menu commands, menus, option buttons, perspectives, 
tabs, tooltip labels, tree elements, views, and windows. 

¶ Represents keys, such as F9 or CTRL+A. 

¶ Represents a term the first time it is defined. 

Courier  Represents file and directory names, code, system messages, and command-line commands.  

Courier Bold  Represents emphasized text in code.  

Select File > Save As Represents a command to perform, such as opening the File menu and selecting Save As.  

Italic ¶ Represents any information to be entered in a field.  

¶ Represents documentation titles.  

<  > Represents placeholder values to be substituted with user specific values.  

Hyperlink Represents a hyperlink. Clicking a hyperlink displays the information topic or external source. 

[name of guide] Reference to another guide that contains additional information on a specific feature. 

http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20WebStudio%20User%20Guide.pdf
http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20Reference%20Guide.pdf
http://openl-tablets.org/
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2 Before You Begin 
This section lists system requirements for OpenL Tablets software and introduces OpenL Tablets WebStudio 
instance properties. The following topics are included: 

¶ System Requirements for OpenL Tablets Software 

¶ Common Information about OpenL Tablets WebStudio Instances 

2.1 System Requirements for OpenL Tablets Software 
The following table covers system requirements for installing and running OpenL Tablets software: 

Software requirements 

Software Requirements description 

Operating systems One of the following: 

¶ Microsoft Windows 7+ x86/64 

¶ Ubuntu 12.x 

¶ Linux 3.x 

Note: OpenL Tablets software can potentially run on any operating system that supports Java 
Virtual Machine, for example, Mac OS. This table lists operating systems on which the 
OpenL Tablets software is tested and supported. 

Browsers One of the following: 

¶ Microsoft Internet Explorer 11.x 

¶ Firefox 60 ESR or later 

¶ Chrome 73+ 

Data Bases One of the following: 

¶ MySQL 5.5+ 

¶ MariaDB 10.2+ 

¶ MS SQL Server 2008+ 

¶ Oracle 11g + 

¶ PostgreSQL 9.5+ 

Other software ¶ Java v8/11/12 x86/64  

¶ Apache Tomcat 7, 8.5, 9 

¶ WebSphere Application Server 8.5 

¶ JBoss EAP 7.1 

Hardware requirements 

 ¶ RAM 4 GB minimum.  
6 GB is recommended. 

¶ 1 GHz or faster 32-bit (x86) or 64-bit (x64) processor. 

User rights requirements 

 Administrative permissions are required to install the software under Microsoft Windows or 
UNIX system. 

Note: It is highly recommended to avoid using spaces and special characters in paths. 
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2.2 Common Information about OpenL Tablets WebStudio 
Instances 

This section provides general information about OpenL Tablets WebStudio home directory structure and 
resources shared among multiple OpenL Tablets WebStudio instances. The following topics are included: 

¶ OpenL Tablets WebStudio Home Directory Configuration 

¶ Starting OpenL Tablets WebStudio in the Cluster Mode 

¶ Sharing webstudio.properties 

¶ Sharing Project History 

¶ Sharing Project Index 

OpenL Tablets WebStudio Home Directory Configuration 

When OpenL Tablets WebStudio is run for the first time, by default ${user.home}/.openl  is used as the 
openl. home or OPENL_HOME directory where the application is deployed. 

This folder contents depends on configuration. Example of its contents is as follows: 

locks  

repositories  which is a settings folder 

user - workspace  that contains .locks  folder and folders by users with .history  folders 

webstudio.prope rties  file 

cache  

repositories  that includes deploy - config  and design  folders 

In case of multiple OpenL Tablets WebStudio instances, a shared file storage can be defined. The 
openl . home. shared  folder must be defined in the application.properties  file before launching OpenL 
Tablets WebStudio for the first time.  

An example of the openl . home. shared  folder contents is as follows: 

locks  

repositories  which is a settings folder 

user - workspace  that contains the .locks  folder and folders by users with .history  folders 

webstudio.properties  file 

An example of the openl . home folder contents is as follows: 

cache  

repositories  that includes deploy - config  and design  folders and by default can be set to one folder 

users - db,  only for a local h2 database 

This option is not available if OpenL Tablets WebStudio is installed using the installation wizard. In this case, 
openl . home. shared  is set equal to openl.home  and it cannot be modified in the installation wizard. 
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Starting OpenL Tablets WebStudio in the Cluster Mode 

To start OpenL Tablets WebStudio in the cluster mode, the openl.home.shared  or OPENL_HOME_SHARED 
property must be defined properly. In the cluster mode, the same file storage can be used for multiple OpenL 
Tablets WebStudio instances. 

 

Figure 1: Multiple OpenL Tablets WebStudio instances sharing the same drive 

Sharing webstudio.properties 

webstud io.properties  can be shared among multiple instances of OpenL Tablets WebStudio. If the 
openl.home.shared  path is added to application.properties  before starting OpenL Tablets WebStudio, and 
it differs from the openl.home  path, a separate folder is created for storing webstudio.properties  file and 
administrative settings can be shared among several instances of OpenL Tablets WebStudio that have one 
openl.home.shared  path. 

Sharing Project History 

Project history can be shared among multiple instances of OpenL Tablets WebStudio. 

It is stored in user workspace, in the openl.home.shared  folder if set up so before launching OpenL Tablets 
WebStudio. Thus, users can view project history from different OpenL Tablets WebStudio instances. 

Sharing Project Index 

Project index can be shared among multiple instances of OpenL Tablets WebStudio to support work with the Git 
non-flat structure repository from different OpenL Tablets WebStudio instances.  The openl - projects.yaml  file 
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that contains a list of projects and their paths is now stored in repositories \ se ttings \ des ign  of the 
openl.home.shared  folder, or openl.home  if the shared folder is not configured. 
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3 Install OpenL Tablets WebStudio under Apache 
Tomcat 

This section describes how to set up the environment for working with OpenL Tablets software and deploy 
OpenL Tablets WebStudio under Apache Tomcat and provides information about settings required for proper 
functioning of the application. 

Perform the following steps: 

¶ Installing JDK 

¶ Installing Apache Tomcat 

¶ Deploying OpenL Tablets WebStudio 

¶ Configuring External User Database 

¶ Setting Up OpenL Tablets WebStudio with Installation Wizard 

¶ Integration with External Identify Providers 

¶ Configuring Microsoft Excel Settings for Apache Tomcat 

¶ OpenL Tablets WebStudio Customization 

3.1 Installing JDK 
To install JDK, perform the following steps: 

1. Download jdk-8u231 or later from http://w ww.oracle.com/technetwork/java/javase/downloads/index.html 
to the target directory. 

Further in the document, this catalog is referred to as <JAVA_HOME>. 

Note: It is highly recommended to avoid installing Java in the default Program Files directory because it can cause 
problems due to space characters in the path to the folder. 

For more information on the installation, see http:// www.oracle.com/technetwork/java/javase/index-
137561.html. 

2. Install JDK according to the instructions. 

Now the environment variable JAVA_HOME must be set to the pathname of the directory where JDK is 
installed. 

3. For MS Windows, set the environment variable JAVA_HOME as follows: 

1. To open the System Properties window, press <Windows> + <Pause> or right click the My Computer 
icon and in the pop-up menu, select Properties. 

2. In the Advanced tab, click Environment Variables. 

3. In the System variables area, click New. 

4. In the Variable name field, enter JAVA_HOME. 

5. In the Variable value field, enter the path to the directory where JDK is installed, for example, 
C: \ Java \ jdk1. 8. 0_231. 

6.  Click OK to complete. 

4. For Unix/Linux environments, assuming the target directory is /usr/li b/jvm/j dk1. 8. 0_231, to set up the 
environment variable JAVA_HOME for a single user, proceed as follows: 

1. Log in to the account and open .b ash_pr ofile:nano ~/. bash_profile . 

http://www.oracle.com/technetwork/java/javase/downloads/index.html
http://www.oracle.com/technetwork/java/javase/index-137561.html
http://www.oracle.com/technetwork/java/javase/index-137561.html
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2. Add the following line: 

export JAVA_HOME=/u sr /lib/jvm/ jdk1.8.0_231 . 

3. Add or correct the system PATH as follows: 
exp ort PATH=$PATH: $JAVA_HOME/b in  

4. To save, press CTRL+O and then press CTRL+X to exit. 

5. For Unix/Linux environments, assuming the target directory is /usr/lib/jvm/ jdk1.8.0_231 , to set up the 
environment variable JAVA_HOME for all users, proceed as follows: 

1. Log in as root and open the nano /etc/pro fi le  profile. 

2. Add the following line:  

export JAVA_HOME=/usr/lib/ j vm/jdk1.8.0 _231 . 

3. Add or correct the system PATH as follows: 

export PATH=$PATH:$JAVA_HOME / bin . 

3.2 Installing Apache Tomcat 
Apache Tomcat can be installed from a ZIP file or using Windows Service Installer. The following topics are 
included in this section: 

¶ Installing Apache Tomcat on Windows 

¶ Installing Apache Tomcat on UNIX / Linux Machine 

Installing Apache Tomcat on Windows 

This section describes how to install Apache Tomcat on Windows and includes the following topics: 

¶ Installing Apache Tomcat from Zip File 

¶ Installing Apache Tomcat Using Windows Service Installer 

Installing Apache Tomcat from Zip File 

To install Apache Tomcat 7.0.x or later, proceed as follows: 

1. Open Apache Tomcat home page at http://tomcat.apache.org/index.html. 

2. In the left-hand Download menu, click the latest available Tomcat version. 

3. Locate the Binary Distributions area and in the Core list, click on the ZIP file corresponding to the required 
Windows version. 

4. Save the ZIP file in a temporary directory. 

5. Extract the downloaded ZIP file into the target folder on the computer.  

This folder is referred to as <TOMCAT_HOME> further in this document. 

6. For Tomcat web server 7.0, to configure JVM options, open the TOMCAT_HOME/conf/server.xml file and 
add the URIEnco ding ="UTF- 8"  attribute for all <Connector>  elements.  

For example: 
<Connector port= "8080" pro tocol="HTTP/1.1 " connectionTim eout="20000 " redirectPort ="8443" 

URIEncod ing= "UTF- 8"/>  

Installing Apache Tomcat Using Windows Service Installer 

This section describes how to install Apache Tomcat using Windows Service Installer. 

http://tomcat.apache.org/index.html
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Note: It is not recommended to select this type of installation if planning to edit rule tables in Excel files from OpenL 
Tablets WebStudio as described in [OpenL Tablets WebStudio User Guide], the Modifying Tables section. This type 
of installation requires additional setup. To solve this issue, contact your OpenL Tablets administrator. 

Note: For OpenL Tablets administrator: to enable editing rule tables in Excel files from OpenL Tablets WebStudio, enable 
the Allow service to interact with desktop Tomcat service option using MMC or from the command line. 

Proceed as follows: 

1. Navigate to the Apache Tomcat site at http:// tomcat.apache.org/index.html and in the left-hand Download 
menu, click the latest available Tomcat version. 

2. Locate the Binary Distributions area and in the Core list, click the 32-bit/64-bit Windows Service Installer 
link. 

Save the apache-tomcat exe file in a temporary folder. 

3. Run the exe file and follow the instructions of the installation wizard. 

4. Click Next. 

5. In the License Agreement window, click I Agree. 

6. In the Choose Components dialog, leave the default Normal type of installation. 

Experienced Tomcat users can select another installation type in the drop-down list. 

7. In the Configuration dialog, proceed with default values. 

8. In the next window, review the folder where Tomcat will be installed, the Destination Folder. 

This folder is referred to as <TOMCAT_HOME> further in this document. 

9. Click Install to start the installation. 

10. Click Finish to complete. 

As a result, Apache Tomcat is installed and started on the ǳǎŜǊΩǎ computer. In the Notifi cation Area located 

next to the clock, the  icon appears. Tomcat is managed by using this icon or from the Start menu. 

11. To configure JVM options for Tomcat, in the Notification area, right click the Apache Tomcat icon and select 
Configure; or click Start > All Programs > Apache Tomcat 7.0 > Configure Tomcat. 

The Apache Tomcat Properties dialog appears. 

12. Click the Java tab and in the Java Options text box, add the following lines: 
- Xms512m 

- Xmx2000 m 

- XX:  +UseConcMarkSwe epGC 

- XX:PermSize=128m  

- XX:MaxPermSize= 512m 

Note that every option must be manually entered in a separate row. 

13. Click Apply and then click OK. 

14. To restart Tomcat, in Notification Area, right click the Tomcat icon and select Stop service. 

The Tomcat icon changes to .  

15. Select Start Service. 

Alternatively, Tomcat can be restarted from the General tab in the Apache Tomcat Properties window 
which appears after selecting Start > All Programs > Apache Tomcat 7.0 > Configure Tomcat. 

From this point, OpenL Tablets WebStudio can be run as described in Deploying OpenL Tablets WebStudio. 

http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20WebStudio%20User%20Guide.pdf
http://tomcat.apache.org/index.html
http://www.sai.msu.su/apache/tomcat/tomcat-7/v7.0.29/bin/apache-tomcat-7.0.29.exe
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Installing Apache Tomcat on UNIX / Linux Machine 

This section describes how to install Apache Tomcat on the UNIX or Linux machine and includes the following 
topics: 

¶ Installing Apache Tomcat from Repository 

¶ Installing Apache Tomcat from ZIP File 

¶ Configuring JVM Options for Tomcat on UNIX / Linux Machine 

Installing Apache Tomcat from Repository 

This section describes how to install Apache Tomcat from repository as a service on Ubuntu 12.x. 

Note: All commands must be entered into a terminal window using an account with sudo  privileges. 

Proceed as follows: 

1. Open a terminal window and enter the following: 
sudo apt - get insta ll tomcat7  

2. Start Tomcat with the next command: 
sudo / et c/i nit.d/ tomc at7 st art  

All necessary folders must be located in /var/lib/tomcat7 . 

3. To ensure that Tomcat works properly, open the browser and enter http://localhost:8080. 

If all is correct, Apache Tomcat displays the welcome page with a message resembling the following: 

 If you're seeing this, you've successfully installed Tomcat. Congratulations! 

If the 404 error appears, try to restart Tomcat as follows: 
sudo  /etc/init .d/tom cat7  restart  

Alternatively, stop Tomcat by entering the following command in command line and then start it as 
described previously: 

sudo /etc/init.d/tomcat7 stop  

Installing Apache Tomcat from ZIP File 

This section describes how to install Apache Tomcat on Ubuntu 12.04 and Centos 6.3. The instructions are valid 
for other Linux distributions with small changes. 

Proceed as follows: 

1. Download the appropriate Tomcat archive file, ZIP or tar.g z archive, from its official website 
http://tomcat.apache.org/download-70.cgi to the required user folder. 

In this example, Tomcat 7.0.39 is downloaded to the /home/myuser folder. 

2. Open a terminal window and change directory to the folder containing the Tomcat archive. 

3. Extract the archive by entering the following command in the terminal, modifying the Tomcat version as 
required: 
tar - zxvf apache - tomcat - 7.0.3 9.tar.gz  

The apache - tomcat - 7.0 .39 folder appears. For example: 
/home/m yuser/apach e- tomcat - 7.0.3 9 

4. Change directory to the tomcat/bin : 
cd apa che - tomcat - 7.0.39/bin  

5. Make sure all *.sh  files are executable, that is, they have r  in all positions to the left of the file name, for 
example, - rw xr - xr - x.  

http://tomcat.apache.org/download-70.cgi
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For that, in terminal, enter the following: 
ls ïla  

The following information is displayed: 

 

Figure 2: OpenL Tablets package is added 

6. If some sh  files are not executable, enter the following command: 
chmod +x ./ *.sh  

7. Run the sturtup .sh  file as follows: 
sh ./star t up.sh  

8. In the browser, enter the following URL:  

http://localhost:8080 

If the installation is completed successfully, the Apache Tomcat welcome screen appears. The next thing to 
be done is to configure JVM options for Tomcat. 

Configuring JVM Options for Tomcat on UNIX / Linux Machine 

To configure JVM options for Tomcat on a UNIX / Linux machine, proceed as follows: 

1. For UNIX, create TOMCAT_HOME/start.cmd  file and type the following: 
expo rt JAVA_OPTS="$ JAVA_OPTS - Xms512m - Xmx2000m - XX:+  UseConcMarkSwee pGC - XX:Pe rmSize=128m 

- XX:MaxPermSize= 512m"  

2. Locate the TOMCAT_HOME/conf/server.xml file and add the URIEncod ing ="UTF- 8"  attribute for all 
<Connector>  elements.  

For example: 
<Connec tor port=" 8080" protocol= "HTTP/1.1" conn ectionTimeo ut="20000" red irectPort= "8443"  

URIEncoding="UTF - 8"/>  

3. From this point, deploy OpenL Tablets WebStudio as described in Deploying OpenL Tablets WebStudio. 

 

http://localhost:8080/


OpenL Tablets Installation Guide Install OpenL Tablets WebStudio under Apache Tomcat 

© 2004-2021 OpenL Tablets 
OpenL Tablets 5.24 Page 16 of 61 

3.3 Deploying OpenL Tablets WebStudio 
This section describes how to deploy and run OpenL Tablets WebStudio under Tomcat. 

The following topics are included: 

¶ Deploying OpenL Tablets WebStudio on a Windows Machine 

¶ Deploying OpenL Tablets WebStudio on a Linux Machine and Max 

Deploying OpenL Tablets WebStudio on a Windows Machine 

This section describes how to deploy and run OpenL Tablets WebStudio under Tomcat on a Windows machine. 

Proceed as follows: 

1. Go to the http://ope nl-tablets.org/downloads page. 

2. Click the appropriate OpenL Tablets WebStudio WAR link. 

3. Save the file in a temporary folder and then copy the OpenL Tablets WebStudio WAR file. 

For example, openl - tab lets - webstudio - X.X.X .war  to the <TOMCAT_HOME>\ webapps  folder. 

4. Run Tomcat as follows: 

¶ If Tomcat is installed from the ZIP file, in TOMCAT_HOME\ bin ,  click the startup. bat  file.  

¶ If Tomcat is installed using Windows Service Installer, restart Tomcat as described in Installing Apache 
Tomcat Using Windows Service Installer. 

Tomcat unpacks the WAR file into the <TOMCAT_HOME>\ webapps \ <war  file name>  folder. For example, for 
5.9.4 version the target folder can be <TOMCAT_HOME>\ webapps \ openl - tablets - webstudio - 5.9.4 . For 
convenience, the folder can be renamed as needed but remember that this name is used to launch OpenL 
Tablets WebStudio under Tomcat. 

From this point on, run OpenL Tablets WebStudio with default settings or make additional customizations by 
changing the user mode and configuring an external user database as described in [OpenL Tablets Rule 
Services Usage and Customization Guide]. 

5. To run OpenL Tablets WebStudio, in the browser, enter the following URL:  

http://localhost:8080/<WAR file name> 

That is, for this example, the URL is http://localhost:8080/openl-tablets-webstudio-5.9.4. 

OpenL Tablets WebStudio is opened in the browser on the Welcome to Installation Wizard page. The wizard 
will guide through the setup process as described in Setting Up OpenL Tablets WebStudio with Installation 
Wizard. When setup is complete, use OpenL Tablets WebStudio to create new projects or download existing 
ones. 

6. After a new release of the OpenL Tablets WebStudio is installed, click CTRL+F5 or clear cookies and cash 
manually to reload the page in the browser. 

Deploying OpenL Tablets WebStudio on a Linux Machine and Mac 

To install OpenL Tablets WebStudio under Linux and Mac OS, perform the following steps: 

1. Create the <OPENL_HOME> folder where the application will be deployed as follows: 
sudo mkdir  / <OPENL_HOME> 

2. Change access rights for this folder by entering the following command in the command line: 
sudo c hmod 775 - R / <OPENL_HOME> 

 

http://openl-tablets.org/downloads
http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20Rule%20Services%20Usage%20and%20Customization%20Guide.pdf
http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20Rule%20Services%20Usage%20and%20Customization%20Guide.pdf
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3. Change the owner for this folder: 
sudo c hown tomcat7:tomcat7 / <OPENL_HOME> 

4. Download OpenL Tablets WebStudio WAR file from https://github.com/openl-tablets/openl-
tablets/releases/  to a temporary folder. 

5. Copy the downloaded WAR file to the Tomcat webapps  folder: 
cp /home/myuser/Downloads/<openl - tablets - webstudio -

xxxx.war>/ home/myuse r/ <TOMCAT_HOME>/webapps/w ebstudio . war  

6. To stop Tomcat, run the following command from /home/myuser/<T OMCAT_HOME>/bin : 
sh shutdown.sh  

7. Start Tomcat from the same folder as follows: 
sh star tup.sh  

8. In the browser, enter http://localhost:8080/webstudio. 

If deployment is completed without errors, the OpenL Tablets WebStudio Installation Wizard described in 
the next step is opened in the browser. 

If encountering any problems, for more information, see the following log files: 
home/myuser/ <TOMCAT_HOME>/logs/catalina.out and 
home/myuser//<TOMCAT_HOME>/logs/web studio.log   

3.4 Configuring External User Database 
This step is only required if a user is planning to work in multi user application modes such as Multi-user, Active 
Directory, SSO: CAS or SSO: SAML. For more information, see Setting Up OpenL Tablets WebStudio with 
Installation Wizard and use an external database such as MySQL for managing users in OpenL Tablets 
WebStudio. 

By default, OpenL Tablets WebStudio can run using an internal user database based on the HSQLDB database 
engine. It is a good idea to use the internal user database for demonstration purposes because it is provided by 
default and requires no additional setup. But in this case, all user management changes will be lost after server 
restart. 

In a production environment, it is strongly recommended to use an external database.  

Note: For more information on supported platforms, see http://openl-tablets.org/. 

The following topics are included: 

¶ Adding Drivers and Installing and Configuring the Database 

¶ Configuring MySQL Database as External User Storage 

¶ Configuring MariaDB Database as External User Storage 

¶ Configuring Oracle Database as External User Storage 

Adding Drivers and Installing and Configuring the Database 

Before configuration, perform the following steps:  

1. Add the appropriate driver library for a database in OpenL Tablets WebStudio to \ WEB- I NF\ lib \ . 

Alternatively, locate required libraries directly in \ <TOMCAT_HOME>\ lib  with other Tomcat libraries. 

https://github.com/openl-tablets/openl-tablets/releases/
https://github.com/openl-tablets/openl-tablets/releases/
http://openl-tablets.org/
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Driver name for appropriate databases 

Database Driver 

MySQL mysql - connector - java - 5.1.31. jar  

MariaDB mar iadb - java - client - 2.0.1.jar  

Oracle ojdbc 6.jar  

MS SQL mssql - j dbc - 7.2. 2.jre8.jar  

PostgreSQL postgresq l - 9.3 - 1100 .jdbc4.jar  

For more information on URL value according to the database type, see the URL value according to the 
database type table in Setting Up OpenL Tablets WebStudio with Installation Wizard. 

2. Install the database, defining login and password and creating a new schema or service. 

Ensure all database settings are completed. 

3. Start OpenL Tablets WebStudio and in the third step, select a Multi -user, Active Directory or SSO mode. 

4. Define database URL, username, and password. 

 

Figure 3: Creating a connection to the Oracle database in the installation wizard  

5. Click Finish to close the wizard when the installation is complete. 

6. Log in with credentials of a default user created in the third step of the installation wizard, in the Configure 
initial users section. 

Note that even after configuring the database as user storage, a default user is available for login. The 
default user can manage user settings in OpenL Tablets WebStudio, for example, create a user or add 
privileges to a user. All user management activities can be performed via the OpenL Tablets WebStudio UI, 
in the Admin > User Management section. 
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Figure 4: Managing users in the User Management section of OpenL Tablets WebStudio 

Right after applying changes in OpenL Tablets WebStudio, the updates are applied to the database. A user can 
log in and work under a newly created account in OpenL Tablets WebStudio. 

Note: During installation, several tables are created in the database. If the same tables exist in the database from the 
previous usage, a conflict occurs. To avoid this situation, the following tables must be removed: 

¶ ACCESSCONTROLENTRY 

¶ GROUP2GROUP 

¶ OPENLUSER 

¶ schema_version 

¶ USER2GROUP 

¶ USERGROUP 

¶ HIBERNATE_SEQUENCE table that has SEQUENCE_OWNER=OPENL 

The previous steps describe configuration when a user starts OpenL Tablets WebStudio for the first time. 
Otherwise, in the openl \ user - wor kspace  folder, the following changes must be made: 

1. In the sy stem - setti ngs  folder, locate the db.propertie s configuration file and edit it described in the 
following example for the Oracle database: 

 

Figure 5: Configuration file with Oracle database settings 
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2. In the system.properti es  file, set variable user.mod e = multi . 

Configuring MySQL Database as External User Storage 

This section explains how to set up a MySQL database. Proceed as follows: 

1. Go to http://dev.mysql.com/downloads/mysql/. 

2. Select the appropriate MSI Installer for system configuration and click Download. 

For example, Windows (x86, 32-bit), MSI Installer may be needed. It is recommended to use ZIP Archive 
version since it is intended for advanced users. 

3. In the next window, register or log in to the MySQL site. 

This step can be skipped, and users can proceed to No thanks, just start my download! link. 

4. In the next window, select Save File and save the .ms i  file in a target folder. 

5. Navigate to the folder containing the . msi file and double click the file to start the installation process.  

The MYSQL Server Setup Wizard Welcome window appears. 

6. Follow the wizard steps leaving the default values and clicking Next to proceed. 

7. Click Finish to close the wizard when installation is complete. 

Note: It is recommended to configure the database server to use the UTF-8 character set. 

When MySQL is successfully installed on the userΩǎ computer, an empty database for OpenL Tablets 
WebStudio in MySQL must be created and permissions to modify this database granted to the user from 
which the OpenL Tablets WebStudio will work with this database. 

8. To open MySQL Command Line Client, select Start > All Programs > MySQL > MySQL Server 5.5 > MySQL 
Command Line Client and enter the following commands: 
CREATE USER open l_use r IDENTIFIED BY 'openl_password';  

CREATE DATABASE openl CHARACTER SET utf 8;  

GRANT ALL PRIVILEGES O N openl.* T O openl_user;  

Configuring MariaDB Database as External User Storage 

This section explains how to set up an MariaDB database. Proceed as follows: 

1. Go to https://downloads.mariadb.org. 

2. Select the appropriate version and click Download. 

3. Select the appropriate MSI Installer for system configuration and click Download.  

4. In the next window, select Save File and save the .msi file in a target folder. 

5. Navigate to the folder containing the .msi file and double click the file to start the installation process. 

The MariaDB Setup Wizard Welcome window appears.  

6. Follow the wizard steps leaving the default values and clicking Next to proceed. 

7. Define password for a root user. 

8. Create a database. 

http://dev.mysql.com/downloads/mysql/
https://downloads.mariadb.org/
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Figure 6: Setting properties for the MariaDB database 

9. Click Finish to close the wizard when the installation is complete. 

10. Start HeidiSQL application.  

11. Click New to create a session. 

12. Select the Prompt for credentials check box and define a database port. 

 

Figure 7: Creating a connection to the MariaDB database 

13. Click Open and save the changes. 
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Configuring Oracle Database as External User Storage 

This section explains how to set up an Oracle database. Proceed as follows: 

1. Go to http://www.oracle.com/technetwork/database/enterprise-edition/downloads/index.html. 

2. After registration, select the appropriate version and system configuration, and click Download. 

3. Unzip 2 archives in one folder and click the exe  file.  

4. Configure the database and define a username and password. 

These values will be used further for configuration. 

5. To improve work with database, download Oracle SQL Developer at 
http://www.oracle.com/technetwork/developer-tools/sql-developer/overview/index.html. 

In this section, as an example, Oracle SQL Developer 3.2.2 is used.  

6. Start Oracle Workbench and create a connection or select an existing database connection. 

 

Figure 8: Creating a connection to the Oracle database   

7. Enter username and password values defined when installing the database. 

3.5 Setting Up OpenL Tablets WebStudio with Installation 
Wizard 

This topic describes the steps that must be taken after the first run of OpenL Tablets WebStudio under Tomcat 
or WebSphere Application Server. For more information, see Install OpenL Tablets WebStudio and OpenL 
Tablets Rule Services on WebSphere Application Server. Accept the default options provided by the wizard by 
clicking Next to move to the next step or change the options as required and click Next to proceed. 

Proceed as follows: 

1. In the Welcome to OpenL Tablets WebStudio Installation Wizard window, click Start. 

2. In the next window, specify a working directory for OpenL Tablets. 

http://www.oracle.com/technetwork/database/enterprise-edition/downloads/index.html
http://www.oracle.com/technetwork/developer-tools/sql-developer/overview/index.html
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By default, the following directory is displayed:  
${ use r . home}/. openl  

This folder is referred to as <OPENL_HOME> in the documentation. It is highly recommended not to use the 
system drive for that.  

3. Click Next to proceed. 

4. Specify deployment and design repositories: 

Connection types for setting up design and deployment repositories 

Type Description 

Database 
(JDBC) 

The repository is located in a database installed either local or remote. The Repository URL field 
displays URL for access to the database. 

Database 
(JNDI) 

The repository is located in a database installed either locally or remotely. The Repository URL 
field displays URL for accessing the database. Configuration settings are located in configuration 
files of the web server application. 

AWS S3 The repository is located in Amazon Simple Storage Service (AWS S3). A άbucketέ is a logical unit of 
storage in AWS S3 and is globally unique. Choose a region for storage to reduce latency, costs etc. 
An Access key and a Secret key are needed to access storage. If empty, the system will retrieve it 
from one of the known locations as described in AWS Documentation. Best Practices for Managing 
AWS Access Keys. The Listener period is the interval in which to check repository changes, in 
seconds. 

Git The Git repository is a version control system. The Git repository can be configured as local or 
remote. The URL field displays URL for the remotely located Git repository or file path to the 
repository stored locally. The Local path identifies the folder where a Git repository local copy is 
stored. For more information on connection settings, see [OpenL Tablets WebStudio User Guide]. 

 

http://docs.aws.amazon.com/general/latest/gr/aws-access-keys-best-practices.html
http://docs.aws.amazon.com/general/latest/gr/aws-access-keys-best-practices.html
http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20WebStudio%20User%20Guide.pdf
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If deploy configuration must be stored in a separate repository, not in Design repository, the Use Design 
Repository check box must be cleared and required parameter values must be provided. 

The following table explains URL values according to the database type: 

URL value according to the database type 

Database URL value 

MySQL, 
MariaDB 

jdbc:mysql: //[host][:port]/[schema]  

Oracle jdb c:oracle:thin:@//[  host ][: port ]/ se r vice  

MS SQL jdbc:sq lser ver://[server Name[ \ i ns tanceName] [:po rt]][; pr operty=value[;proper t

y=value]]  

PostgreSQL j dbc:postgresql://[ho st][:port] / [schema ]  

For more details about how to configure the repository of a specific type, please refer to the corresponding 
subchapter below: 

¶ Configuring OpenL Tablets WebStudio via JDBC Connection 

¶ Configuring OpenL Tablets WebStudio via JNDI Connection 

¶ Configuring OpenL Tablets WebStudio via Amazon Simple Storage Service 

For more information on repository security, see [OpenL Tablets WebStudio User Guide], the Repository 
Settings section. 

5. Click Next. 

6. Select a user mode as described in the following table: 

User modes 

Mode Description 

Demo This is a multi user mode with the list of users predefined in the default database. The database 
does not require additional setup. All changes in the database will be lost after the application 
restart. 

Single-user  Only the user currently logged on to the computer can work with the OpenL Tablets WebStudio. 
For more information on the single user mode, see [OpenL Tablets WebStudio User Guide]. 

Multi-user 
(recommended)  

Multiple users can run OpenL Tablets WebStudio with their unique names. WebStudio is used to 
authenticate and manage user credentials/permissions with External database. 

Active Directory Multiple users can run OpenL Tablets WebStudio using their unique user names. Active Directory 
will be used to authenticate and manage user credentials. 

SSO: CAS Multiple users can run OpenL Tablets WebStudio using their unique user names. CAS (Central 
Authentication Service) server will be used to authenticate and manage user credentials. 

SSO: SAML Multiple users can run OpenL Tablets WebStudio using their unique user names. SAML (Security 
Assertion Markup Language) supporting Identity Provider server will be used to authenticate and 
manage user credentials. 

For Active Directory, SSO: CAS, SSO: SAML, user modes proceed as described in Integration with External 
Identity Providers. 

7. If Multi -user, Active Directory, SSO: CAS or SSO: SAML mode is selected, in the Configure database area 
that appears, modify the database parameters as follows: 

http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20WebStudio%20User%20Guide.pdf
http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20WebStudio%20User%20Guide.pdf
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Database parameters 

Parameter Description 

Database URL  Enter the URL for the selected database. 

Login / Password  Username and password specified for the database as defined in Configuring External User 
Database. 

8. Click Finish to complete setup. 

As a result, for the Demo, Mult i-user, Active Directory, SSO: CAS and SSO: SAML modes, the login screen 
appears for entering userΩǎ Ŏredentials to start working with OpenL Tablets WebStudio. If the openl.home 
registry variable is defined, upon OpenL Tablets WebStudio update, after replacing the war file, re-running 
installation wizard is not required as the fact of configuration is recorded in the system registry. However, if 
there are multiple instances of OpenL Tablets WebStudio installed on the same computer, OpenL Tablets 
WebStudio must be run via system properties.  

For a list of users predefined in the Demo application mode, see [OpenL Tablets WebStudio User Guide], User 
Management > Manage Users. 

Configuring OpenL Tablets WebStudio via JDBC Connection 

Configure design and deployment repositories settings on the second step of OpenL Tablet WebStudio 
installation wizard as follows: 

1. Select JDBC as the type of the connection database (JDBC). 

2. Provide URL and authentication data. 

If the Deployment repository is created in an OpenL Tablets version older than 5.20, the Version in 
deployment name check box must be selected to enable backward compatibility. 

http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20WebStudio%20User%20Guide.pdf
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Figure 9: Setting up a JDBS connection using the installation wizard 

Configuring OpenL Tablets WebStudio via JNDI Connection 

To configure the OpenL Tablets WebStudio via JNDI connection, perform the following steps: 

¶ Configuring Resources for JNDI Context 

¶ Configuring Settings in OpenL Tablets WebStudio 

Configuring Resources for JNDI Context 

Resource settings must be configured before deploying the application. Proceed as follows: 

1. Open the \ co nf \ context.xml  file in Apache Tomcat and add the Resourc e tag as described in the following 
examples. 

For the Oracle database, an example is as follows: 
<Resource na me=òjdbc/oracleJ NDI ò auth =òContainer ò 

            type= òjavax.s ql . Data Source ò username =òuse rò password= òpasswo rd ò 

            driv erClassName= òorac le.jdbc.Or acleDriver ò  

            url= òjdbc: oracle:thi n:@localhost :1521:orcl ò 

            maxAct ive= ò8ò     

            />  
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For the MySQL database, an example is as follows: 
<Resource name=òjdbc / mysqlJNDI ò auth= òContai ner ò type= òjavax.sql .DataSource ò 

               maxActive =ò100ò maxIdl e=ò30ò maxWait= ò10000ò 

               username= òjavau ser ò pass word= òjavadude ò 

driverClassNam e=òcom.mysq l.jdbc.Dri ver ò 

               url= òj dbc:mys ql://l ocalhost:3 306/j avatest ò 

               />  

For the MS SQL database, an example is as follows: 
<Resource n ame=òjdbc/ mssqlJNDI ò auth= òContainer ò 

            typ e=òjavax. sq l.DataSource ò username= òwall yò passwo rd =òwally ò 

            driverClassName =òcom.microso ft.sqlserv er.jd bc.SQLServerDriver ò  

            url= òj dbc:sqlserver://l ocalhost;D atabaseNam e=mytest;Sele ct Method=cur sor; ò 

            maxActive= ò8ò  

            />  

For the PostrgeSQL database, an example is as follows: 
<Resource name=òjdbc/postg resò auth=òContainerò 

            type=òjavax.sq l.DataS ourceò username=òpostgresò password=òPassword1ò 

            dr iverClassN ame=òorg.postgresql.Driverò  

            url=òjdbc:p ostgresql:// l ocalhost:5432/p ostgresò 

            maxActive=ò8ò  

            / > 

2. Save the context.xm l  file.   

Configuring Setti ngs in OpenL Tablets WebStudio 

Configure design and deployment repositories settings on the second step of OpenL Tablets WebStudio 
installation wizard as follows: 

1. Select JNDI as the type of the connection database. 

2. Enter a URL in the java:co mp/env/<reso urce name>  format. 

Definition of the authentication data, that is, login and password, is not required in the installation wizard 
because this information is set in context.x ml  file already. 

3. If the Deployment repository was created in an OpenL version older than 5.20, the ŎƘŜŎƪōƻȄ  ά±ŜǊǎƛƻƴ ƛƴ 
deployment naƳŜέ must be checked to enable backward compatibility 
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Figure 10: Setting up JNDI connection with installation wizard 

Configuring OpenL Tablets WebStudio via Amazon Simple Storage Service 

Configure design and deployment repositories settings on the second step of OpenL Tablets WebStudio 
installation wizard as follows: 

1. Select AWS S3 as the type of connection. 

2. Specify the following information: 

AWS S3 parameters 

Parameter Description 

Bucke t name  Enter the name of the bucket in which your data resides. 

Region name  Select the name of the AWS region in which your bucket resides. 

Access key  Enter your Amazon AWS access key. 

Secret key  Enter your Amazon AWS secret access key. 

Listen er  period  
(sec)  

The time, in seconds, to wait for the Amazon server to respond. 

Version in 
deployment n ame  

Select the Version in deployment name check box for backward compatibility if the 
deployment repository is created in an OpenL Tablets version older than 5.20. 

3.6 Integration with External Identity Providers 
To enhance sign in options for users, a third-party authentication can be established between organization 
authentication systems and OpenL Tablets WebStudio. After enabling third-party authentication, users can sign 
into OpenL Tablets using their organizational credentials. 

The following topics are included in this section: 
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¶ Local vs. External User Management 

¶ Configuring Authentication via Active Directory 

¶ Configuring Single Sign On via CAS 

¶ Configuring Single Sign On via SAML Server 

Local vs. External User Management 

OpenL Tablets WebStudio allows selecting where user permissions are managed in the case of integration with 
external identity providers. The following options are available: 

¶ local user management 

An administrator can create any groups and manage authenticated user permissions in OpenL Tablets 
WebStudio.  

¶ external user management 

User groups are managed in Active Directory or SSO. Configure OpenL Tablets groups equal to Active 
Directory or SSO groups in step 4 of the installation wizard. To configure OpenL Tablets groups, proceed as 
described in [OpenL Tablets WebStudio User Guide], Managing Groups section. 

For any of these options, first, initial users must be defined in the Configure initial users section that appears in 
the third step of the installation wizard. Proceed as follows: 

1. Provide at least one user to be granted administration privileges in the Administrators field. 

2. Select the All authenticated users have View access check box to grant viewer privileges by default. 

 

Figure 11: Configuring initial users 

Configuring Authentication via Active Directory  

This section explains how to set up authentication via Active Directory. Proceed as follows: 

1. Select Local user management or External user management. 

The steps required for this configuration are described in Local vs. External User Management.  

2. Specify Active Directory domain and URL. 

3. To verify connection to Active Directory, enter credentials of the existing Active Directory user and click 
Check Connection. 

http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20WebStudio%20User%20Guide.pdf
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Figure 12: Configuring authentication via Active Directory 

Configuration also can be defined via properties as follows: 

security.ad.dom ai n=ldap server .com   

security.a d.server - url =ld ap:// ldap server :3268  

securi ty.a d.grou ps - are - managed - in - stud i o=false  

security.ad.default - gr oup=Vi ewers  

security.ad.search - filter =(&(objectClass=user)(userPrinci palNa me={0 }))  

security.ad.group - filter =(&(objectClas s=group)(member:1.2.840.113556 .1.4.1941:={2}) )  

Configuring Single Sign On via CAS 

This section explains how to set up authentication via CAS. Proceed as follows: 

1. Select Local user management or External user management. 

The steps required for this configuration are described in Local vs. External User Management. 

2. Define the following parameters: 

CAS configuration parameters 

Parameter Description 

WebStudio server 
URL 

URL for OpenL Tablets WebStudio. 

CAS server URL URL for the selected CAS server. 

Attribut e for First 
Name 

CAS attribute for the first name. Keep it blank if the CAS server does not return this 
attribute. 

Attribute for Second 
Name 

CAS attribute for the second name. Keep it blank if the CAS server does not return this 
attribute. 

Attribute for Groups CAS attribute for groups. Keep it blank if the CAS server does not return this attribute. 
Applicable for Local user management only. 

 No te:  Contact CAS serv er administrator for attrib ute  names information.  
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Figure 13: Configuring CAS 

Configuring Single Sign On via SAML Server 

This section explains how to set up authentication via the SAML server. Proceed as follows: 

1. Select Local user management or External user management. 

The steps required for this configuration are described in Local vs. External User Management. 

2. Define the following parameters: 

SAML configuration parameters 

Parameter Description 

WebStudio server 
URL 

URL for OpenL Tablets WebStudio. 

Metadata trust 
check 

Identifier that is set by default to true for verifying metadata signature. When metadata is not 
signed, the value must be set to false to disable verification. 

Max 
authentication age 

Maximum time between user authentication and processing of an authentication statement. 

The value is in seconds. 

SAML server 
metadata URL 

URL of the metadata XML file of the Identity Provider. 

Request timeout Time, in milliseconds, to wait for the metadata server to respond. 

SAML remote 
server X509 
certificate 

PEM Base-64 encoded string, which contains a public key for SAML IDP Server. The begin and 
end tags are not required. 

Authentication 
Contexts 

Comma separated list of authentication contexts that IDP is allowed to use when 
authenticating a user. This value can be left blank. 

Local logout Identifier that can be set to true for local logout, logging out only from OpenL Tablets 
WebStudio, or false for global logout, logging out from all services using this IDP. 

Attribute for  
Username 

SAML attribute for a username. Keep it blank if SAML server does not return this attribute, or if 
default algorithm for username retrieval must be used. 

Attribute for  First 
Name 

SAML attribute for the first name. Keep it blank if SAML server does not return this attribute. 
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SAML configuration parameters 

Parameter Description 

Attribute for 
Second Name 

SAML attribute for second name. Keep it blank if SAML server does not return this attribute. 

Attribute for 
Groups 

SAML attribut e for groups. Keep it blank if the SAML server does not return this attribute. This 
parameter is applicable to external user management only. 

Is load-balancer or 
reverse-proxy 
used in front of 
the local 
application 

Identifier that must be set to true if load-balancer or reverse-proxy are used in front of the 
OpenL Tablets WebStudio instance server. 

Scheme of the 
load-balancer 

Scheme of the load-balancer server. The values are http  or https. 

Server name of 
load balancer 
server 

Server name of the load balancer. 

Port of the load 
balancer 

Port of the load balancer. 

Include port to the 
requestURL 

Identifier that, if set to true, denotes whether the port will be used in construction of load 
balancer requestURL. 

Context path of 
the load balancer 

Context path of the load balancer. The value must be started with slash. 
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Figure 14: Configuring SAML 

The following topics describe SAML configuration: 
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¶ Configuring SAML on Apache Tomcat with Load Balancer 

¶ Configuring SAML on Azure Kubernetes 

Configuring SAML on Apache Tomcat with Load Balancer 

If OpenL Tablets WebStudio instance is deployed on Tomcat and load balancer in front of the application, add 
the following lines to the Tomcat /conf/server.xml file: 

<Valve c la ssName="org.apache.catalina.v alves.Rem oteI pValve "  

                       in te rnal Proxies=".*"  

                       protocolHeader= "X - Forwarded - Proto"  

                       httpsServerPort="443"  

/>  

Configuring SAML on Azure Kubernetes 

SAML configuration on Azure Kubernetes includes the following steps: 

¶ If the OpenL Tablets WebStudio Docker image is deployed on Azure Kubernetes, set the parameters on the 
Azure Basic SAML configuration as follows: 

Azure SAML configuration parameters 

Parameter Description 

Identifier (Entity ID) Audience of the SAML response for IDP-initiated SSO. 

Example: https:/ /example.com/openl/webstudio/saml/metadata 

Reply URL Destination in the SAML response for IDP-initiated SSO. 

Example: https:/ /example.com/openl/webstudio/saml/SSO 

Logout URL Called URL for the logout operation. 

Example: https:/ /example.com/openl/webstudio/saml/SingleLogout 

URLs must be accessible by Azure. 

¶ To specify the Azure metadata URL in the OpenL Tablets WebStudio, search for App Federation Metadata 
URL in the Azure SAML Signing certificate. 

Username, first name, last name, group, and other attributes can also be retrieved from App Federation 
Metadata XML. 

¶ Build the image with the required JDBC driver. 

OpenL Tablets WebStudio stores information about users and their groups in the database, so there must be 
a remote database server when OpenL Tablets WebStudio is used in Kubernetes.  

¶ Predefine groups if OpenL Tablets WebStudio catches groups from the metadata XML by group attribute 
property and external group management is selected. 

For example, use the following command to add a group from Active Directory to the database: 
ins ert  into openl_groups( groupna me, descript ion)  VALUES (<name_o f_gr oup_in_ ad>,  

<description>);  

This query adds a group to OpenL Tablets WebStudio. After that, to add authorities to this group, use one of 
the following approaches: 

¶ Use default groups from OpenL Tablets WebStudio and create a link to them as follows: 
ins ert into openl_ gr oup2group(groupid, in cludedgroupid) VALUES (<created_gro up_id>, 

<existing_group_in_openl_with_author ities>);  

¶ Give a defined authority directly to the created group as follows: 

inser t into openl_group_authorities(groupid , au thorit y) VALU ES (<created_group _i d>, 

<existing_authority_id>);  

https://example.com/openl/webstudio/saml/SSO
https://example.com/openl/webstudio/saml/SingleLogout
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In Kubernetes, application configuration is described in the configuration map and installer must not be used. 
For an example of the configuration, see Appendix B: OpenL Tablets WebStudio Image Configuration for SAML. 

3.7 Configuring Microsoft Excel Settings for Apache Tomcat 
The Open in Excel functionality does not work under the default settings if Apache Tomcat is installed on 
Windows using Windows Service Installer as described in Installing Apache Tomcat Using Windows Service 
Installer. This case requires a user to make several configuration changes. 

To change DCOMConfig settings for Excel, proceed as follows: 

1. Run the dcomconfi g.exe  utility using administrator credentials: 

Start > dcomcnfg.exe  

The Component Services window appears. 

2. In Console Root, select Component Services > Computers > My Computer > DCOM Config. 

3. Navigate to the Microsoft Excel Application at the right. 

If Microsoft Excel Application is not available under DCOMConfig settings, on the 64 bit system with 32 bit 
Office, select Start > Run mmc -32 > File > Add/Remove Snap-iƴΧ Ҕ /ƻƳǇƻƴŜƴǘ Services > Add > OK > 
Console Root > Component Services > Computers > My Computer > DCOM Config > Microsoft Excel 
Application. 

4. Right click Microsoft Excel Application and in the drop-down menu, select Properties. 

5. In the Microsoft Excel Application window, click the Identity tab. 

6. Select This user. 

7. Click OK to complete. 
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Figure 15: Microsoft Excel application properties 

3.8 OpenL Tablets WebStudio Customization 
This section describes additional configuration for OpenL Tablets WebStudio and includes the following topics: 

¶ Updating User Database Configuration 

¶ Configuring User Mode 

¶ Configuring Google Analytics 

¶ Configuring Private Key for Repository Security 

Updating User Database Configuration  

User database settings, such as connection, login, and password data, are modified using the 
<OPENL_HOME>/system - setting s/ db.properties  file. 

An example of the configuration that can be used for the user database is as follows: 

db.hibernate .d ialect = org.hi bernate.dia le ct.MySQL Dial ect  

db.dri ver = com.mysql.jdbc . Driver  

db.url =  jdbc:mysql:/ /localhost :3306/ open l  

db.user = ope nl_u ser  

db.password = openl_password  

Configuring User Mode 

Normally, user mode in OpenL Tablets WebStudio is set to multi-user by using OpenL Tablets WebStudio 
Installation Wizard as described in Setting Up OpenL Tablets WebStudio with Installation Wizard. 
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User mode can also be changed as a JVM option for Tomcat. For that, open the Apache Tomcat Properties 
dialog as described in Installing Apache Tomcat Using Windows Service Installer, and in the Java Options text 
box, add the following line: 

- Duser . mode=mul ti  

Note: User mode set as a Java option takes precedence over the corresponding value specified in the OpenL Tablets 
WebStudio Installation Wizard. If both are defined, the Java option value is used. 

Configuring Google Analytics 

Google Analytics is a service offered by Google that generates detailed statistics about website traffic and traffic 
sources. To configure Google Analytics for OpenL, open the Apache Tomcat Properties dialog as described in 
Installing Apache Tomcat Using Windows Service Installer and in the Java Options text box, add the following 
lines: 

- Dwebstudio.a nalytics=nu mber  

Alternatively, configure Google Analytics for OpenL in the config.p roperties file located in \ WEB- INF \ conf \  

as follows: 

webstudio.analytics=numbe r  

number  is a number provided by Google during registration. 

Configuring Private Key for Repository Security 

OpenL Tablets WebStudio allows connecting to secured repositories. In this case, passwords are stored in OpenL 
Tablets WebStudio workspace. To improve passwords protection, a private key can be used. 

Private key is a special secure sentence for coding and encoding repository passwords. By default, the private 
key is empty. It can be set up as a JVM option for Tomcat by adding and specifying the value of the following 
parameter: 

reposito ry.encode.decode.key .  

The private key must be specified without spaces. 

Note: The private key must be configured prior to creating any secured connections. Otherwise, all stored passwords 
become invalid. 

To enable private key usage for password encoding, modify the repository . encode.decode.k ey  property in 
the {TOMCAT_HOME}\ webapps{APP_NAME}\ WEB- INF \ conf \ sys t em.properties  file.  By default, for OpenL 
Tablets Rule Services, this property is empty, and for OpenL Tablets WebStudio, it contains the This is the key 
for password secure phrase. 

https://en.wikipedia.org/wiki/Google
https://en.wikipedia.org/wiki/Statistics
https://en.wikipedia.org/wiki/Website
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4 Deploy OpenL Tablets Rule Services under Apache 
Tomcat 

This chapter is designed for rule developers who need to use business rules as separate web services. 

For more information on how to configure OpenL Tablets Rule Services, see [OpenL Tablets Rule Services Usage 
and Customization Guide]. 

Before deploying OpenL Tablets Rule Services under Apache Tomcat, ensure the following tasks are performed: 

¶ The JAVA_HOME environment variable is set to the pathname of the directory where JDK is installed. 

¶ JVM options are set up as described in Installing Apache Tomcat. 

The folder where Tomcat is installed is referred to as <TOMCAT_HOME>.  

This section contains the following topics: 

¶ Downloading Preconfigured OpenL Tablets Rule Services 

¶ Configuring OpenL Tablets Rule Services for a Local Data Source 

¶ Configuring OpenL Tablets Rule Services for a Database Data Source 

¶ Configuring OpenL Tablets Rule Services via GIT Connection 

4.1 Downloading Preconfigured OpenL Tablets Rule Services 
To download the preconfigured OpenL Tablets Rule Services application in a WAR file, proceed as follows: 

1. Locate http://openl-tablets.org/downloads. 

2. Click the appropriate OpenL Tablets Rule Services WAR link. 

3. Save the WAR file to the <TOMCAT_HOME>\ webapps  directory.  

4.2 Configuring OpenL Tablets Rule Services for a Local Data 
Source 

This section describes how to configure settings for a local storage with deployed projects there. The following 
topics are included: 

¶ Configuring OpenL Tablets Rule Services via Local File System 

¶ Configuring OpenL Tablets Rule Services via Local ZIP Archives 

¶ Configuring OpenL Tablets Rule Services via Classpath JAR 

Configuring OpenL Tablets Rule Services via Local File System 

Using a file system as a data source for user projects means that projects are stored in a local folder. This folder 
represents multi deployments containing one or multiple projects for each deployment. Each deployment must 
be represented as a separate folder and, at the same time, the project must also be represented as a separate 
folder inside the deployment folder. 

To deploy OpenL Tablets Rule Services, configure a local file system as a data source as follows: 

http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20Rule%20Services%20Usage%20and%20Customization%20Guide.pdf
http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20Rule%20Services%20Usage%20and%20Customization%20Guide.pdf
http://openl-tablets.org/downloads
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4. Open the WEB- INF \ cla sses \ applica tio n.prop ertie s file. 

5. Set the following properties with the following values: 
pr oduction - r epository.fac tory =  r epo- f i l e  

production - repo sitory . uri  = d :/datasource/  

Note: For proper parsing of Java properties file, the path to the folder must be defined with a slash όΨκΩύ as the folders 
delimiter. Bacƪ ǎƭŀǎƘ ά\έ is not allowed. 

6. Save the rule project in the appropriate dat asource  folder.  

Every rule project must be represented as a separate folder. As an example, use OpenL Tablets Tutorial 
available at http://o penl-tablets.org/documentation/tutor ials. 

7. To run Tomcat, in <TOMCAT_HOME>\ bin,  click the startup.bat  file. 

To ensure the deployment is successful, try loading the appropriate CXF page with web services. 
An example is htt p://localh ost: 8080/openl - tablets - ws- X.X.X .  

Note: The Tomcat log file contains a URL that must be used to run the OpenL Tablets Rule Services. For a file system data 
source, the URL must resemble http://loc alhost:8080 / <ws war file name>/< r ul e pr oj ect  

ur l >?wsdl , where <r ul e pr oj ect  ur l > can be taken from the Tomcat log file. 

Users can also pack their rule projects in a j ar  file and use this file as a data source as described in [OpenL 
Tablets Rule Services Usage and Customization Guide], JAR File Data Source section. 

Configuring OpenL Tablets Rule Services via Local ZIP Archives 

Using a local zip archive as a data source for user projects means that zipped projects are stored in a local folder. 
This folder represents rule project or deployment as a separate zip archive: 

¶ Each dependent rule projects must be represented as a deployment zip archive and each project must be in 
a separate folder inside the deployment archive. 

¶ Each independent rule project must be represented as a separate zip archive. 

To set up local zip archives for deployment to OpenL Tablets Rule Services, proceed as follows: 

1. Open the WEB- IN F\ cla sses \ applica tion.propertie s file. 

2. Set the following properties with the following values: 
 production - repo sit ory.factory  = r epo- zi p 

 produ ct i on- repo sitory.uri = d:/dat asource  

3. Save the zipped rule projects in the appropriate dat asource  folder. 

Every rule project must be represented as a separate archive. As an example, use OpenL Tablets tutorial 
available at http://o penl-tablets.org/documentation/tutor ials. 

It is also possible to configure separate zip archives from different locations. For that, set up the production -

repositor y. ar chi ves property and define the exact address to the zip archive. Use the comma ά,έ separator to 
configure multiple archives. An example is as follows: 

production - repositor y. ar chi ves = d:/ dat aso urce / pr oj ect 1. z i p,  c:/ f ol der / pr oj ect 2. z i p 

Configuring OpenL Tablets Rule Services via Classpath JAR 

If rule projects with the r ules.xml  project descriptor in the archive root or deployments with the 
depl oyment . xml  or depl oyment . yaml  deployment descriptor in the archive root are packed into a JAR file and 
placed in the classpath , these projects are deployed at the application launch. It is default configuration. 

To set up a classpath JAR for deploy to OpenL Tablets Rule Services, proceed as follows: 

http://openl-tablets.org/documentation/tutorials
http://localhost:8080/openl-tablets-ws-X.X.X
http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20Rule%20Services%20Usage%20and%20Customization%20Guide.pdf
http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20Rule%20Services%20Usage%20and%20Customization%20Guide.pdf
http://openl-tablets.org/documentation/tutorials


OpenL Tablets Installation Guide Deploy OpenL Tablets Rule Services under Apache Tomcat 

© 2004-2021 OpenL Tablets 
OpenL Tablets 5.24 Page 40 of 61 

1. Open the WEB- INF \ cla sse s\ applica tion.propertie s file. 

2. Set the following properties with the following values: 
 production - repo sit ory.fact ory  = r epo- j ar  

3. Put the JAR file with the project to \ <TOMCAT_HOME>\ webapps \ <rule servic es file name> \ WEB- INF \ lib . 

Alternatively, zip archives with deployments or rule projects can be saved to \ <TOMCAT_HOME>\ webapps \ <rule 

servic es file name> \ WEB- INF \ cl asses\ openl .  

4.3 Configuring OpenL Tablets Rule Services for a Database 
Data Source 

This section describes how to configure settings to connect to a database for storing deployed projects there. 
Such configuration requires that the appropriate database exists and is launched. The following topics are 
included: 

¶ Configuring OpenL Tablets Rule Services via JDBC Connection 

¶ Configuring OpenL Tablets Rule Services via JNDI Connection 

¶ Configuring OpenL Tablets Rule Services via AWS S3 Connection 

Before configuration, add the appropriate driver library for a database in OpenL Tablets Rule Services to \ WEB-

INF \ l ib \ . Alternatively, locate required libraries directly in \ <TOMCAT_HOME>\ lib  with other Tomcat libraries. 
Install the database, defining a login and password and creating a new schema or service.  

For more information on drivers, see the Driver name for appropriate databases table in Adding Drivers and 
Installing and Configuring the Database. 

Configuring OpenL Tablets Rule Services via JDBC Connection 

To set up JDBC connection settings for OpenL Tablets Rule Services, proceed as follows: 

1. Open the WEB- I NF\ classes \ applica tion.propert ies  file. 

2. Set the following properties with the following values:  
production - repository.fact or y = r epo- j dbc 

production - repository .uri = j dbc:mysql:/ /l ocal host/de ploymen t - re posi to ry  

3. Set the URL value for producti on- repositor y. ur i  according to the appropriate database as described in 
the URL value according to the database type table in Setting Up OpenL Tablets WebStudio with Installation 
Wizard. 

4. Set the login produ ction - reposi tor y.login and password prod uc ti on- repositor y.password for 
connection to the database defined while installing the database. 

The password must be encoded via the Base64 encoding schema when rep os itor y.encod e.decod e. ke y is 
also defined.  

Configuring OpenL Tablets Rule Services via JNDI Connection 

This section describes how to configure JNDI connection when OpenL Tablets Rule Services is started under 
Apache Tomcat. Before configuration, ensure that resources are set up in the context.xm l  file as described in 
Configuring Resources for JNDI Context. 

To configure OpenL Tablets Rule Services via JNDI connection, proceed as follows: 
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1. Open the WEB- INF \ cla sses \ applica tion.propertie s file. 

2. Set the following properties with the following values: 
production - repo sit ory.factory  = r epo- j ndi  

produ ct io n- repo sitory.uri = ja va:comp/env/ jdbc/depl oy ment DB 

3. Change the URL value for production - repo sitory. ur i  according to the appropriate database as described 
in the URL value according to the database type table in Setting Up OpenL Tablets WebStudio with 
Installation Wizard. 

Note: Login and password are not required for definition inside the appli cation.pro pert ies  file while 
configuring JNDI settings. 

Configuring OpenL Tablets Rule Services via AWS S3 Connection 

This section describes how to configure an AWS S3 connection when OpenL Tablets Rule Services is started 
under Apache Tomcat. 

To configure OpenL Tablets Rule Services via an AWS S3 connection, proceed as follows: 

1. Build a customized version of OpenL Tablets Rule Services with dependencies on 
*org. openl.rules.repo sitory.aws  v5. 20.5 4 * : 

Create a pom.xml file with the following content for this: 

<?xml versi on=" 1.0 " encod in g="UTF- 8"?>  

<pro jec t xmlns="h ttp: / /maven.apache.org/P OM/4.0. 0"  

xml ns :x si="ht tp://www.w3.org /20 01/XMLSch ema- inst ance" 

xsi:schemaLocati on="http://mav en.apache. or g/ POM/4.0.0  http://maven.apac he.org/m aven -

v4_0_ 0.xs d">  

    <modelVersion>4.0.0</m ode l Ver sion>  

    <groupId>com .ex ample.openl</ grou pId>  

    <artifactId >webser vi ce - aws</ artifa ctId>  

    <pack agi ng>war< /p ackaging > 

    <version>1.0 - bet a</version>  

 

    <proper ti es > 

        <project.build.so urceEnco ding>UTF - 8</pr oject.buil d.sourceEncoding>  

        <org.ope nl .v ersion> #Def i ne OpenL Tabl et s ver si on her e#</or g.openl.ve rsio n> 

    </properties>  

    <depende nc ie s> 

        <dependenc y> 

            <grou pId>org . openl.rul es</g ro upId>  

            <ar tifac tId>org.o penl.rules.repository.aws< /artifactI d> 

            <version>${org.o pen l.v ersion}</ve r sio n> 

        </depe ndency>  

        <dependency>  

            <group Id >org.ope nl.rules</group Id>  

            <art ifactId >org .openl .rule s. ruleservice. ws</ar tif actId > 

            <type>war</type>  

            <versi on>${org.o penl.version}</ve rsi on> 

        </ dependency>  

    </dep endencies>  

    <dependencyManageme nt>  

        <dependenci es>  

            <dependency > 

                <groupI d>com.f asterxml.jac kson.c ore </gro upId>  

                <artifactId>j ackson - dat abin d</artifac tId>  

                <version>2. 11. 4</v ersion>  

            </depen denc y> 

            <depe ndency>  

                <groupId>com.f ast erxml.jac kson.cor e</grou pId>  
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                <artifac tId >ja ckson - annotations </artifactId>  

                <versi on>2. 11. 4</vers ion>  

            </d ependency > 

            <depen dency>  

                <groupId>commons - codec</ gr oupI d> 

                <artif act Id>common s- codec< /arti fa ctId > 

                <versio n>1.1 5</versio n> 

            </dependency>  

        </depen denci es>  

    </ dependency Management > 

</ proj ect>  

2. Add the following properties to the application.properti es  file: 

produc ti on- repository.factory  = r epo- aws- s3 

productio n- repository.b ucket - name = yourBucketName  

produ ct ion - reposi t ory .region - name = you rS3Region  

pr oduction - rep osit ory.access - key = yo urAccessKe y 

produ ction - repo si tory. secret - ke y = yo ur SecretKey  

4.4 Configuring OpenL Tablets Rule Services via GIT 
Connection 

To configure OpenL Tablets Rule Services via a GIT connection, build a customized version of OpenL Tablets Rule 
Services with dependencies on org.openl.rules :  org.o penl.rules.repository.git  as well: 

1. Create a pom.xml file with the following contents: 
<?xml version="1.0" encoding="UTF - 8"?>  

<project  xmlns="http ://ma ven.apache.org/POM/4.0.0" 

xmlns:xsi="h ttp://www.w3.org/2001/XMLSchema - instance" 

xsi:schemaLocation="http: //maven.apache.org/POM/4.0.0 http://maven.apache.org/mav en-

v4_ 0_0.xsd">  

    <modelVersi on>4 .0.0</modelVersion>  

    <groupId>com.exampl e.openl</gro upId>  

    <artifactId>webservice - git</artif actId>  

    <packaging>war</packaging>  

    <version>1.0 - beta</versio n> 

 

    <properties>  

        <project.build.sourceEncodi ng>UTF- 8</project.build.sourceE ncod ing>  

        <org.openl.version> #Def i ne OpenL Tabl et s ver si on her e#</or g.openl.version>  

    </prop erties>  

    <dependencies>  

        <dependency>  

            <groupI d>org.openl.rules</groupId>  

            <artifactId>org. openl. rules.repository.git</art ifactId>  

            <ve rsion>${org.openl.version}</version > 

        </depe ndency>  

        <dependency > 

            <groupId>org.openl.rules</groupId>  

            <artif actId>org.openl.rules.ruleservice.ws</artifactId>  

            <type>war</type>  

            <version>${org.openl .version}</version>  

        </depen dency > 

    </dep endencies>  

    <dependencyM anagement>  

        <dependencies>  

            <dependency>  

                <groupId>com.fasterxml.jackson.core</groupId>  
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                <artifactId>jacks on- databind</artifactId>  

                <version>2.1 1. 4</v ersio n> 

            </dependency>  

            <dependency>  

                <groupId>com.fasterxml.jack son.core </groupId>  

                <artifactId>jackson - annotatio ns</ar tifactId>  

                <version>2.1 1. 4</version>  

            </dependency>  

            <dependenc y> 

                <groupId >commons- codec</groupId>  

                <artifactId>common s- codec< /artifactId>  

                <version>1.1 5</version>  

            </dependency>  

        </dependencies>  

    </dependencyManagement>  

</project>  

2. Add the following properties to the application .properties  file: 
production - repo sit ory.factory  = r epo- gi t  

produ ct i on- repo sitory.uri = https:// gi t hub. com/ <your - name>/ <your - r epo>.git  

produ ct io n- repo sitor y. l ogi n = your - l ogi n 

produ ct io n- repo sitory. passwor d = your - passwor d 
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5 Install OpenL Tablets WebStudio and OpenL 
Tablets Rule Services on WebSphere Application 
Server 

This section explains how to install OpenL Tablets WebStudio and OpenL Tablets Rule Services on WebSphere 
Application Server. The following topics are included: 

¶ Prerequisites 

¶ Setting Up JVM Options for WebSphere Application Server 

¶ Preparing OpenL Tablets WAR Files 

¶ Deploying OpenL Tablets Web Applications on WebSphere Application Server 

¶ Configuring Settings for JDBC Connection 

¶ Configuring Settings for JNDI Connection 

¶ Configuring Microsoft Excel Settings for WebSphere Application Server 

5.1 Prerequisites 
Before deploying OpenL Tablets WebStudio on WebSphere Application Server, IBM WebSphere Application 
Server v. 8.5 or later must be installed on the uǎŜǊΩǎ local machine, or users must be granted access to a 
WebSphere Application Server instance with logon that has appropriate permissions to configure JVM options.  

For more information on how to install IBM WebSphere Application Server, see Oracle online documentation, 
section Installing and Configuring WebSphere 8.5 at 
http://docs.oracle.com/cd/E24902_01/doc.91/e23435/inst_config_was85_win.htm 

IMPORTANT! When defining the Shared Resource Directory during the installation process, the path to the 
directory must be specified without spaces. Otherwise, OpenL Tablets WebStudio fails. 

5.2 Setting Up JVM Options for WebSphere Application 
Server 

To set up JVM options for WebSphere Application Server, proceed as follows: 

1. In WebSphere Application Server Console, navigate to Servers/ ServerTypes/ WebSphere Application 
Servers.  

The server appears in the right pane.  

2. In the right pane, click the server name. 

The default value is server1. 

3. Locate the Server Infrastructure area and expand the Java and Process Management node. 

4. Click Process definition. 

5. In the upper right part of the window, click the Java Virtual Machine link. 

6. In the Initial heap size text box, enter 256. 

7. In the Maximum heap size text box, enter 1024. 

http://docs.oracle.com/cd/E24902_01/doc.91/e23435/inst_config_was85_win.htm


OpenL Tablets Installation Guide Install OpenL Tablets WebStudio and OpenL Tablets Rule Services on WebSphere Application Server 

© 2004-2021 OpenL Tablets 
OpenL Tablets 5.24 Page 45 of 61 

8. In the Generic JVM Arguments, add the following line:  
- XX:+Use Para l lelOldGC - XX:Per mSize=128m - XX:MaxPermSize =384M -

Dclient.encod ing.override=UT F- 8 

9. Click OK. 

10. In the Message window which appears in the top of the form, click Save directly to the master 
configuration to save changes. 

11. Restart WebSphere Application Server. 

5.3 Preparing OpenL Tablets WAR Files 
This section describes how to configure OpenL Tablets WebStudio and OpenL Tablets Rule Services WAR files. 
Proceed as follows: 

1. Locate http://openl-tablets.org/downloads. 

2. Click the appropriate OpenL Tablets WAR link. 

3. Save the file in a temporary folder. 

4. Open the downloaded WAR file as a ZIP archive. 

5. In the \WEB- IN F\ li b\  folder, remove the following JAR files: 

¶ jboss-transaction-api_1.2_spec-1.0.0.Final.jar 

¶ geronimo-jta_1.1_spec.jar 

6. Save the WAR file. 

5.4 Deploying OpenL Tablets Web Applications on 
WebSphere Application Server 

This section describes how to deploy OpenL Tablets WebStudio and OpenL Tablets Rule Services on WebSphere 
Application Server and includes the following topics: 

¶ Deploying OpenL Tablets WebStudio on WebSphere Application Server 

¶ Deploying OpenL Tablets Rule Services on WebSphere Application Server 

Deploying OpenL Tablets WebStudio on WebSphere Application Server 

To deploy OpenL Tablets WebStudio on WebSphere Application Server, proceed as follows: 

1. In a browser, enter the following URL: 

https:/ /localhost:9043/ibm/console 

This is a default port for local installation. The WebSphere Application Server Console window appears. 

2. Navigate to Applications / Application Types / WebSphere enterprise applications. 

3. In the top line tool bar, click the Install button. 

4. In the Path to the new application area, select the modified OpenL Tablets WebStudio WAR file. 

The Local file system option is selected by default. 

5. Click Next till Step 2. 

6. In the Step 2: Map modules to servers page, select the check box on the left to the file name and click Next. 

http://openl-tablets.org/downloads
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7. In the Step 3: Map virtual hosts for Web modules page, select the check box on the left to the file name and 
click Next. 

8. In the Step 4: Map context roots for Web modules page, in the Context Root text field, enter /webstudio 
and click Next. 

9. Click Finish to complete.  

10. When the installation process is complete, click the Manage Applications link. 

11. In the next window, in the list of applications, click the OpenL Tablets WebStudio WAR file link. 

12. In the next window, locate the Detail Properties area and click the Class loading and update detection link. 

13. In the next window, select the following radio buttons: 

¶ Classes loaded with local class loader first (parent last) 

¶ Single class loader for application 

14. Click OK to finish. 

15. In the next window, click the Save directly to the master configuration link. 

Now the OpenL Tablets WebStudio application is installed and started. If not, start the application. 

16. Run OpenL Tablets WebStudio by entering http://localhost:9080/webstudio/ in a browser. 

The Welcome to OpenL Tablets WebStudio Installation Wizard window appears allowing to set up the 
application as needed. For more information on the application setup, see Configuring External User 
Database, Setting Up OpenL Tablets WebStudio with Installation Wizard and OpenL Tablets WebStudio 
Customization. 

Deploying OpenL Tablets Rule Services on WebSphere Application Server 

To deploy OpenL Tablets Rule Services on WebSphere Application Server, complete steps 1-16 described in 
Deploying OpenL Tablets WebStudio on WebSphere Application Server. 

For more information on configuring the OpenL Tablets Rule Services settings, see Deploy OpenL Tablets Rule 
Services under Apache Tomcat. 

5.5 Configuring Settings for JDBC Connection 
To configure OpenL Tablets WebStudio or OpenL Tablets Rule Services, prepare war files as described in 
Preparing OpenL Tablets WAR Files and then do one of the following: 

¶ Configuring OpenL Tablets WebStudio via JDBC Connection 

¶ Configuring OpenL Tablets Rule Services via JDBC Connection 

5.6 Configuring Settings for JNDI Connection 
This section describes configuring JNDI connection settings and includes the following topics: 

¶ Configuring Global JNDI Context 

¶ Configuring Local JNDI Context 

Configuring Global JNDI Context 

 To configure global JNDI settings, perform the following actions: 
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¶ Configuring Authentication Data 

¶ Defining a JDBC Provider 

¶ Creating a Data Source 

Configuring Authentication Data 

To configure authentication data, proceed as follows: 

1. Open the https://localhost:9043/ibm/console login page. 

2. Select Security ς Global > Authentication > Java Authentication and Authorization Service. 

3. Click J2C authentication data.  

4. In the window that appears, click New, fill in all mandatory fields, and click Ok and Save.  

 

Figure 16: Setting up global security in WebSphere 

Defining a JDBC Provider 

To define a JDBC provider, proceed as follows: 

1. In the Resources section on the left panel, click JDBC providers and select the appropriate scope of the 
current user and server.  

 

Figure 17: Configuring scope for new JDBC provider  

2. Click New to create a provider.  

3. Select the required Database type, for example, Oracle, Provider type, for example, Oracle JDBC Driver, 
Implementation type, for example, Connection pool data source, enter the name, and click Next.   

https://localhost:9043/ibm/console
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Figure 18: Creating a JDBC provider  

4. In the next page, fill in the location to appropriate driver for the Oracle database as described in the 
following example excluding the name of library itself: 

 

Figure 19: Defining the location of appropriate database lib 

5. Click Ok and Finish on the last installation page.  

6. Click Save to complete and save provider.  

Creating a Data Source 

To create a data source, proceed as follows: 

1. In Data source section, select the appropriate scope of the current user and server.  

2. Click New.  

3. Provide basic data source information, such as data source name and JNDI name. 

 

Figure 20: Configuring a data source 

4. Click Next.  

5. Select a JDBC provider and click Next.  

6. Define URL of the appropriate data user to connect to. 
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An example is jdbc:oracle:thin:@localhost:1521:orcl. 

7. Ensure that the Use this data source in container managed persistence (CMP) option is cleared and click 
Next.  

8. Define authentication settings. 

 

Figure 21: Configuring a data source 

9. Click Next and Finish and then save the created configuration.  

When the JNDI connection is created and saved, a user can connect to the database where deployment 
repository will be stored. The database URL, that is, JNDI name, must have a short version of it without 
prefixes java: comp/ env/jdbc/  because it is configured as a global JNDI context. 

 

Figure 22: Connecting to the database in OpenL Tablets WebStudio via global JNDI context 

To start OpenL Tablets WebStudio on WebSphere, proceed as described in Deploying OpenL Tablets WebStudio 
on WebSphere Application Server.   

To start OpenL Tablets Rule Services on WebSphere, proceed as described in Deploying OpenL Tablets Rule 
Services on WebSphere Application Server.  
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Figure 23: Configuration settings for OpenL Tablets Rule Services via global JNDI context 

Configuring Local JNDI Context  

Typically, Enterprise JavaBeans (EJB) does not use the global name to look up the data source while configuring 
JNDI connection in an enterprise application, such as WebSphere. Instead, EJB uses a logical JNDI name that is 
mapped to the global JNDI name of the data source. Proceed as follows: 

1. To map a logical JNDI name to the global JNDI data source name, declare a resource reference in the 
deployed application \ WEB- INF \ web.xml  file as follows:  
<r esource - ref > 

        <description> Resource refe rence to a f actor y for java .sql  </description>  

        <res - ref - name>jdbc / JNDIName</res - ref - name> 

        <res - typ e>j ava x.sql.Dat aSource</res - t ype>  

        <res - auth >Containe r</res - auth>  

</resou rc e- re f>  

The value of the <res - r ef - name> tag is a logical JNDI name EJB uses to look up the data source. The value of 
the <jnd i - name> tag is a global name of the data source to which the logical name is mapped.  

2. When the resource reference settings are added, save the file and repack the application. 

3. Start deploying OpenL Tablets WebStudio or OpenL Tablets Rule Services as described in Deploying OpenL 
Tablets WebStudio on WebSphere Application Server, steps 1-5. 

4. In the Map resource references to resources window, in the Set Multiple NDI Names list, select Target 
Resource JNDI Name and click Next. 

 

Figure 24: Configuring mapping for a local JNDI context 

5. Complete configuration as described in Deploying OpenL Tablets WebStudio on WebSphere Application 
Server, steps 7-16.  
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5.7 Configuring Microsoft Excel Settings for WebSphere 
Application Server 

The Open in Excel functionality does not work if WebSphere Application Server 8.5 is used under default 
settings. Execute configuration changes described in Configuring Microsoft Excel Settings for Apache Tomcat. 
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6 Install OpenL Tablets WebStudio and OpenL 
Tablets Rule Services on JBoss Application Server 

This section explains how to install OpenL Tablets WebStudio and OpenL Tablets Rule Services on JBoss 
Application Server in a standalone mode.  

The following topics are included: 

¶ Deploying OpenL Tablets WebStudio on JBoss Application Server 

¶ Deploying OpenL Tablets Rule Services on JBoss Application Server 

¶ Setting Up a JDBC Connection 

¶ Setting Up a JNDI Connection 

6.1 Deploying OpenL Tablets WebStudio on JBoss 
Application Server 

To deploy OpenL Tablets WebStudio on JBoss Application Server, proceed as follows: 

1. Rename the OpenL Tablets WebStudio war file to webs tudi o.w ar . 

2. Copy webstudio.war  to the <JBoss home direc tory >\ standa lone \ deploym ents  directory. 

3. If the auto - deploy - zippe d attribute is set to true  in the sta nda l one.x ml  file, manually create an empty 
file webstu dio.wa r.d odeploy . 

4. Run the <JBoss home directo ry >\ bi n\ standalone. bat  file. 

5. Verify that the webstudio .w ar.deployed  marker is generated. 

6. To run OpenL Tablets WebStudio, in a browser, enter http:/ /localhost:8080/webstudio/. 

7. The Welcome to OpenL Tablets WebStudio Installation Wizard window. 

8. Set up the application as required. 

6.2 Deploying OpenL Tablets Rule Services on JBoss 
Application Server 

To deploy OpenL Tablets Rule Services on JBoss Application Server, proceed as follows: 

1. Rename the OpenL Tablets Rule Services file to webservice .war .  

2. Copy the webser vi ce.war  file to the <JBos s home directory> \ sta ndalon e\ deploy ment s  directory. 

3. Run the <JBoss home di rec tory >\ bin \ stan dalone .bat  file. 

4. Verify that the webser vi ce. war.dep loyed  marker is generated. 

5. To run OpenL Tablets Rule Services, in a browser, enter http:// localhost:8080/webservice/ . 
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6.3 Setting Up a JDBC Connection 
To set up a JDBC connection for OpenL Tablets WebStudio, proceed as follows: 

1. Download a required JDBC driver. 

2. Run < JBoss home dire ct ory > \ bin \ standalone.bat .  

3. Run JBoss command line client <JBoss  home dir ectory >\ bin \ jb oss- cli .bat .  

4. In Jboss-cli:, connect to the server using the connect  command. 

5. In Jboss-cli:, add a module using the following command: 

modul e add -- name=<module name> -- r esources= <pat h to the drive r>  --

depend encies=javax.a pi,j avax.transaction. api  

An example of the MySQL driver copied to the <JBoss home directory >\ bi n directory is as follows: 

module add  - - name=or g.mysql -- resources=mysql - con nect or - java - 8.0.1 1.jar --

dependen cies=javax.a pi,javax. transa ction.api  

6. To prepare *.wa r  files for deployment, in the META- I NF\ jb oss - deployme nt - struc tu r e.x ml  file, add the 
following structure: 

<dependencies>  

  <module n ame="< module_name >" export="true" />  

</ dependencies>  

7. For webservice.war , in the appl ication .propert ies  file, specify a connection to the database as follows: 

pr oducti on- repositor y.fac tor y = or g.ope nl.r ules.repositor y.db. JdbcDBReposit ory Factory  

production - r epository . uri = jdbc:mysql://localhost/ depl oyment - reposi tory  

8. Ensure that the applica tion.p roperties  file is άǾisƛōƭŜέ at the JBoss launch location. 

For example, if the appli catio n.proper ti es file is located in  JBoss home directory, JBoss  must be run 
from this directory via the bin \ standalone. bat  command. 

9. Configure a JDBC connection for OpenL Tablets WebStudio as described in Configuring OpenL Tablets 
WebStudio via JDBC Connection. 

6.4 Setting Up a JNDI Connection 
To set up a JNDI connection settings for OpenL Tablets WebStudio, proceed as follows: 

1. Copy a database driver to the <JBos s home direc to ry> \  sta ndal one \ deplo yments \  directory. 

2. Run the <JBos s home directory >\ bin \ sta ndalone . bat  file. 

3. In a browser, enter http://localhost:8080/. 

4. Click Administration console. 

5. Click the Configuration link. 

6.  Select Subsystems > Datasources > Non-XA. 

7. Click Add. 
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Figure 25: Configuring a JNDI connection 

8. In the Create Datasource window, select a data source and click Next. 

9. Enter the data source name and JNDI name and click Next. 

10. Switch to the Detected Driver tab. 

 

Figure 26: JDBC Driver collection 
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11. Select a JDBC driver and click Next. 

12. Specify database connection settings and click Next. 

13. To test the JDBC connection, click Test Connection. 

14. Click Next and then click Finish. 

15. For webservi ce.war , in the application.proper ties  file, specify the connection to a database as follows: 

production - rep os itory.f act or y = 

org.o penl.rules. repositor y. db.DatasourceDB RepositoryFactor y 

productio n- repository.uri  = <JNDI Name>  

16. Configure a JNDI connection for OpenL Tablets WebStudio as described in Configuring Settings in OpenL 
Tablets WebStudio. 














